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Disclaimer 

The information contained in this publication is subject to change without notice. VERITAS Software 
Corporation makes no warranty of any kind with regard to this manual, including, but not limited to, 
the implied warranties of merchantability and fitness for a particular purpose. VERITAS Software 
Corporation shall not be liable for errors contained herein or for incidental or consequential damages 
in connection with the furnishing, performance, or use of this manual. 

VERITAS Legal Notice 

Copyright © 1999-2004 VERITAS Software Corporation. All rights reserved. VERITAS, the VERITAS 

Logo, and all other VERITAS product names and slogans are trademarks or registered trademarks of 

VERITAS Software Corporation. VERITAS and VERITAS NetBackup, the VERITAS logo, Reg. U.S. Pat.

& Tm. Off. Other product names and/or slogans mentioned herein may be trademarks or registered

trademarks of their respective companies.


Portions of this software are derived from the RSA Data Security, Inc. MD5 Message-Digest 

Algorithm. Copyright 1991-92, RSA Data Security, Inc. Created 1991. All rights reserved. 


VERITAS Software Corporation

350 Ellis Street

Mountain View, CA 94043 

USA

Phone 650–527–8000 Fax 650–527–2908

www.veritas.com


Third-Party Copyrights 
ACE 5.2A: ACE(TM) is copyrighted by Douglas C.Schmidt and his research group at Washington University and University of California, Irvine, 
Copyright (c) 1993-2002, all rights reserved. 

IBM XML for C++ (XML4C) 3.5.1: Copyright (c) 1999,2000,2001 Compaq Computer Corporation; Copyright (c) 1999,2000,2001 Hewlett-Packard 
Company; Copyright (c) 1999,2000,2001 IBM Corporation; Copyright (c) 1999,2000,2001 Hummingbird Communications Ltd.; Copyright (c) 
1999,2000,2001 Silicon Graphics, Inc.; Copyright (c) 1999,2000,2001 Sun Microsystems, Inc.; Copyright (c) 1999,2000,2001 The Open Group; All 
rights reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to 
deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies 
of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission 
notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting 
documentation. 

This product includes software developed by the Apache Software Foundation (http://www.apache.org/). 

JacORB 1.4.1: The licensed software is covered by the GNU Library General Public License, Version 2, June 1991. 

Open SSL 0.9.6: This product includes software developed by the OpenSSL Project * for use in the OpenSSL Toolkit. (http://www.openssl.org/) 

TAO (ACE ORB) 1.2a: TAO(TM) is copyrighted by Douglas C. Schmidt and his research group at Washington University and University of 
California, Irvine, Copyright (c) 1993-2002, all rights reserved. 
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Preface

This guide explains how to configure and use NetBackup for Lotus Notes® for UNIX to 
perform online backups and restores of Lotus® databases and Lotus transaction log 
extents. 

This guide is intended for system administrators responsible for configuring and 
maintaining systems using Lotus databases. This guide assumes: 

◆  A basic understanding of system administration. 

◆	 A working understanding of the NetBackup client and server software and familiarity 
with the information covered in the following NetBackup manuals: 

◆	 NetBackup Backup, Archive, and Restore Getting Started GuideNetBackup System 
Administrator’s Guide for UNIX, Volume I or NetBackup System Administrator’s Guide 
for Windows, Volume I 

◆ NetBackup Troubleshooting Guide for UNIX and Windows 

◆ A thorough understanding of the following Lotus topics: 

◆ Database file types and their relationships at recovery time 

◆ Data recovery scenarios 
vii 
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What Is In This Manual? 
What Is In This Manual? 
This guide is organized as follows: 

Chapters in This Manual 

Chapter Description 

“Introduction” Describes the features of NetBackup for Lotus Notes for UNIX. 

“Installation”	 Provides details on installing NetBackup for Lotus Notes for 
UNIX. 

“Configuration”	 Provides details for configuring NetBackup for Lotus Notes for 
UNIX. 

“Operating Instructions”	 Contains a description of NetBackup backup and restore options 
for NetBackup for Lotus Notes for UNIX. It also contains 
troubleshooting tips. 

“Lotus Domino Partitioned How to use NetBackup with Domino partitioned servers. 
Servers” 

“Lotus Domino Clustering” How to use NetBackup with Domino clustering technology. 

“Troubleshooting”	 Offers a comprehensive set of debug logs for troubleshooting 
problems that may occur during NetBackup operations. 

Getting Help 
VERITAS offers you a variety of support options. 

Accessing the VERITAS Technical Support Web Site 

The VERITAS Support Web site allows you to: 

◆	 obtain updated information about NetBackup, including system requirements, 
supported platforms, and supported peripherals 

◆ contact the VERITAS Technical Support staff and post questions to them 

◆ get the latest patches, upgrades, and utilities 
viii NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Getting Help 
◆ view the NetBackup Frequently Asked Questions (FAQ) page


◆ search the knowledge base for answers to technical support questions


◆ receive automatic notice of product updates


◆ find out about NetBackup training


◆ read current white papers related to NetBackup


The address for the VERITAS Technical Support Web site follows:


◆ http://support.veritas.com


Subscribing to VERITAS Email Notification Service 

Subscribe to the VERITAS Email notification service to be informed of software alerts, 
newly published documentation, Beta programs, and other services. 

Go to http://support.veritas.com. Select a product and click “E-mail Notifications” on the 
right side of the page. Your customer profile ensures you receive the latest VERITAS 
technical information pertaining to your specific interests. 

Accessing VERITAS Telephone Support 

Telephone support for NetBackup is only available with a valid support contract. To 
contact VERITAS for technical support, dial the appropriate phone number listed on the 
Technical Support Guide included in the product box and have your product license 
information ready for quick navigation to the proper support group. 

▼ To locate the telephone support directory on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the Phone Support icon. A page that contains VERITAS support numbers from 
around the world appears. 
Preface ix 
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NetBackup Manuals 
Accessing VERITAS E-mail Support 

▼ To contact support using E-mail on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the E-mail Support icon. A brief electronic form will appear and prompt you to: 

◆ Select a language of your preference 

◆ Select a product and a platform


◆ Associate your message to an existing technical support case


◆ Provide additional contact and product information, and your message


3. Click Send Message. 

Contacting VERITAS Licensing 

For license information call 1-800-634-4747 option 3, fax 1-650-527-0952, or e-mail 
amercustomercare@veritas.com. 

NetBackup Manuals 
The following manuals, along with the online help, are included in the NetBackup 
documentation set. For a more detailed listing of NetBackup documents, refer to 
NetBackup Release Notes for UNIX and Windows. 

If you have a UNIX server, refer to these documents: 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume I 

NetBackup_AdminGuideI_UNIXServer.pdf 

Explains how to configure and manage NetBackup on a UNIX server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume II 

NetBackup_AdminGuideII_UNIXServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for UNIX 
x NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Glossary 
Explains how to configure and manage the storage devices and media on UNIX 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

If you have a Windows server, refer to these documents: 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume I 

NetBackup_AdminGuideI_WinServer.pdf 

Explains how to configure and manage NetBackup on a Windows server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume II 

NetBackup_AdminGuideII_WinServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for Windows 

Explains how to configure and manage the storage devices and media on Windows 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

Glossary 
If you encounter unfamiliar terminology, consult the NetBackup online glossary. The 
glossary contains terms and definitions for NetBackup and all additional NetBackup 
options and agents. 

The NetBackup online glossary is included in the NetBackup help file. 
Preface xi 
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Glossary 
▼ To access the NetBackup online glossary 

1. In the NetBackup Administration Console, click Help > Help Topics. 

2. Click the Contents tab. 

3. Click Glossary of NetBackup Terms.


Use the scroll function to navigate through the glossary.

xii NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Accessibility Features 
Accessibility Features 
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include: 

◆	 Support for assistive technologies such as screen readers and voice input (Windows 
servers only) 

◆	 Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys 

For more information, see the NetBackup System Administrator’s Guide for Windows, 
Volume I or the NetBackup System Administrator’s Guide for UNIX, Volume I. 

Conventions 
The following conventions apply throughout the documentation set. 

Product-Specific Conventions 

The following term is used in the NetBackup 5.1 documentation to increase readability 
while maintaining technical accuracy. 

◆ Microsoft Windows, Windows 

Terms used to describe a specific product or operating system developed by 
Microsoft, Inc. Some examples you may encounter in NetBackup documentation are, 
Windows servers, Windows 2000, Windows Server 2003, Windows clients, Windows 
platforms, or Windows GUI. 

When Windows or Windows servers is used in the documentation, it refers to all of 
the currently supported Windows operating systems. When a specific Windows 
product is identified in the documentation, only that particular product is valid in that 
instance. 

For a complete list of Windows operating systems and platforms that NetBackup 
supports, refer to the NetBackup Release Notes for UNIX and Windows or go to the 
VERITAS support web site at http://www.support.veritas.com. 
Preface xiii 
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Conventions 
Typographical Conventions 

Here are the typographical conventions used throughout the manuals: 

Conventions 

Convention Description 

GUI Font	 Used to depict graphical user interface (GUI) objects, such as fields, 
listboxes, menu commands, and so on. For example: Enter your 
password in the Password field. 

Italics	 Used for placeholder text, book titles, new terms, or emphasis. Replace 
placeholder text with your specific text. For example: Replace filename 
with the name of your file. Do not use file names that contain spaces. 

This font is also used to highlight NetBackup server-specific or operating 
system-specific differences. For example: This step is only applicable for 
NetBackup Enterprise Server. 

Code	 Used to show what commands you need to type, to identify pathnames 
where files are located, and to distinguish system or application text that 
is displayed to you or that is part of a code example. 

Key+Key	 Used to show that you must hold down the first key while pressing the 
second key. For example: Ctrl+S means hold down the Ctrl key while 
you press S. 

You should use the appropriate conventions for your platform. For example, when 
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX. 
Significant differences between the platforms are noted in the text. 

Tips, notes, and cautions are used to emphasize information. The following samples 
describe when each is used. 

Tip Used for nice-to-know information, like a shortcut. 

Note	 Used for important information that you should know, but that shouldn’t cause any 
damage to your data or your system if you choose to ignore it. 

Caution	 Used for information that will prevent a problem. Ignore a caution at your own 
risk. 
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Conventions 
Command Usage 

The following conventions are frequently used in the synopsis of command usage. 

brackets [ ] 

The enclosed command line component is optional. 

Vertical bar or pipe (|) 

Separates optional arguments from which the user can choose. For example, when a 
command has the following format: 

command arg1|arg2


In this example, the user can use either the arg1 or arg2 variable. 

Navigating Multiple Menu Levels 

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a 
continued action. 

The following example shows how the > is used to condense a series of menu selections 
into one step: 

❖	 Select Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 

The corresponding actions could be described in more steps as follows: 

1. Click Start in the task bar. 

2. Move your cursor to Programs. 

3. Move your cursor to the right and highlight VERITAS NetBackup. 

4.	 Move your cursor to the right. First highlight and then click NetBackup 
Administration Console. 
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Introduction 
1


NetBackup for Lotus Notes for UNIX extends the capabilities of NetBackup to include 
online backups and restores of Lotus databases when Domino Server has been installed. 
This capability is provided as an add-on or extension to the NetBackup for UNIX client 
software. Because this product is tightly integrated with the Backup, Archive, and Restore 
interface for UNIX, this document only gives an overview of NetBackup functionality. In 
general, backup and restore operations for Lotus database files are identical to other 
NetBackup file operations, except where noted in this document. 

At the time of this release NetBackup for Lotus Notes for UNIX supports the following 
versions of Domino Server: 

◆ R5.0.3 or later 

◆ R6.0.2 or later 

When referring to Domino Server throughout this manual, it implies one of the supported 
versions. 
1 
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Features 
Features 

Online Backup	 Lotus databases and transaction logs can be backed up without 
taking down the Domino Server. This ensures the availability of 
Lotus services and data during the Lotus backup. 

Restore Operations	 Using a few simple operations, an administrator using the 
NetBackup client can browse Lotus database backups and select 
the ones to be restored. 

Transaction Logging	 NetBackup for Lotus Notes for UNIX takes advantage of the 
ability of Lotus Domino to log transactions against one or more 
Lotus R5/R6 databases. Transaction Logging may be circular style, 
linear style, or archive style. 

Point in Time Transaction logging enables NetBackup for Lotus Notes for UNIX 
Recovery to perform a point-in-time recovery of a logged Lotus R5/R6 

database(s). 

Tight NetBackup 
Integration 

Tight integration with NetBackup means two things: 

◆	 An administrator already familiar with NetBackup procedures 
and software will have no problems configuring and using 
NetBackup to perform backup and restore operations for 
Lotus databases and transaction log extents. 

◆	 All of the rich features and strengths of the NetBackup 
product suite are available to the Lotus database backup user. 

Central 
Administration 

Administrators can define Lotus Notes policies, back up and 
restore Lotus databases, and back up and restore archive style 
transaction log extents from a central location. 

Media Management	 Lotus database backups are saved directly to a wide variety of 
storage devices supported by the NetBackup master server. 

Automated Backups	 Administrators can set up schedules for automatic, unattended 
backups for local or remote clients across the network. These 
backups can be full or incremental and are managed entirely by 
the NetBackup server from a central location. The administrator 
can also manually back up clients. 
2 NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Features 
Domino Partitioned 
Server Backup 

Administrators can back up databases from Domino partitioned 
servers by specifying the NOTES_INI_PATH= directive in the 
Backup Selections list. Users can restore databases backed up from 
Domino partitioned servers by specifying the absolute path for the 
notes.ini file that is associated with the server instance to be 
used by the restore. This path can be specified in the Lotus Notes 
tab on the Restore Marked Files dialog box. 

To back up multiple Lotus partitions from a single policy, each 
partition must be backed up using a separate data stream. This is 
accomplished by adding, to the Backup Selections list, the 
NEW_STREAM directive and the appropriate NOTES_INI_PATH= 
directive for each data stream. 
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Lotus Database 
Lotus Database 

Lotus Database Configurations 
NetBackup for Lotus Notes for UNIX supports the backup and restore of three database 
configurations that are supported by Lotus. These configurations can be divided into two 
categories: Domino Server databases and Local databases. 

Domino Server 
Databases 

Logged Domino 
Server Databases 

Unlogged Domino 
Server Databases 

Local Databases 

Domino Server databases are managed by the Domino Server. 
Domino Server databases are located in a directory referred to as 
the Domino data directory, typically /db/notesdata. Domino 
Server databases may also be linked to this Domino data 
directory using Lotus Linked Directories or Databases. Domino 
Server databases can be Logged or Unlogged. 

A feature of Domino Server is the ability to log transactions 
against one or more Lotus databases. If transaction logging is 
enabled on the server, all logged database transactions go into a 
single transaction log, consisting of one or more files or extents. 
Where archive style transaction logging is used, the archived log 
files serve as the incremental backup for the logged databases. 
Transaction logging must be enabled in order to initiate the 
recovery of logged databases using NetBackup for Lotus Notes 
for UNIX. 

An unlogged database is one in which transaction logging is not 
enabled, or has been disabled for specific server database(s). 

Unlogged Domino Server databases will be backed up when a 
full backup is performed. Unlogged Domino Server databases 
will also be backed up when a differential-incremental backup or 
cumulative-incremental backup is performed and the Unlogged 
Domino Server database has been recently updated. The 
database can be restored only to the point of the latest database 
backup. 

Local databases are Lotus databases that are not located in the 
Domino data directory, cannot be shared, and cannot be logged. 
Local databases will be treated similarily to unlogged Domino 
Server databases when being backed up and restored. 
4 NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Lotus Database 
Lotus Database Files 
This section describes the set of files that may be backed up during a backup operation. 

Database Files 

NetBackup for Lotus Notes for UNIX will currently enumerate all Lotus databases with 
the following extentions: 

.NTF  Lotus Notes Template Files 

.NSF  Lotus Notes Server Files 

.BOX  Lotus Notes Mail Box Files 

To allow Lotus databases with other extensions to be backed up (or to limit the default list 
of extensions), create the file /usr/openv/netbackup/lotus.conf. If the 
lotus.conf file exists, the default extensions will be overridden and only those 
databases with the extensions listed will be backed up. When creating the lotus.conf 
file, enter each extension on a separate line. Enter only the extension: no leading period or 
trailing characters are allowed. 

Transaction Logs 

Lotus Domino Server has the ability to log transactions against one or more Lotus R5/R6 
databases. Because transactions cannot be logged against database versions earlier than 
Domino R5, these pre-R5 Lotus databases will be treated as unlogged databases. 

All Lotus R5/R6 databases are logged by default when: 

◆ Transaction logging is enabled by the administrator. 

◆ The database is in the Domino data directory. 

All logged database transactions go into a single transaction log, consisting of one or more 
files or extents. 

Transaction logging may be of either circular, linear, or archive style. When archive style 
transaction logging is used, the archive log files may serve as the incremental backup for 
logged databases. 

Note
 Transaction logging must be enabled in order to implement the recovery of logged 
Lotus databases. 
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Lotus Database 
Circular, Linear, and Archive Style Logging 

When logging is enabled on the Domino Server, one of three styles of logging can be 
selected for all logged databases: circular, linear, or archive style logging. 

When circular-style logging is enabled, the transaction log extents are reused as the 
specified log file size is reached. By reusing the transaction log extents, you are saving 
resources, but limiting your recovery options. It is important to remember that transaction 
log extents are not backed up by NetBackup for Lotus Notes for UNIX when circular-style 
logging is enabled. Therefore, you will be able to recover logged Lotus databases only 
back to the point in time when the circular transaction log extents were overwritten. 

When linear-style logging is enabled, the transaction log extents function the same as for 
circular-style logging, with one exception. Unlike circular-style logging, where the size of 
the transaction log extents are predefined and limited, for linear-style logging, the size of 
the transaction log exents are user-defined and limited in size only by the amount of mass 
storage available. 

When archive style logging is enabled, transaction log extents are generated as needed 
and are limited in number only by the capacity of your mass storage. Unlike circular-style 
and linear-style transaction log extents, which cannot be backed up, archive-style 
transaction log extents must be backed up and may be used as the incremental backup for 
all logged databases. Backing up the archive-style transaction log extents is the only way 
to ensure that the transaction log extents are marked as available to be recycled and to 
prevent your mass storage from filling up. Unlike circular-style and linear-style logging, 
archive style logging does not limit the point in time to which a database may be 
recovered. With archive-style logging enabled, a logged database may be recovered to any 
point in time, from the time the database itself was last backed up to the current time. 

Recycling Transaction Log Extents 

Following either a full backup or differential-incremental backup, NetBackup for Lotus 
Notes for UNIX will mark the successfully backed up archive-style transaction log extents 
as ready to be recycled. The NetBackup for Lotus Notes for UNIX agent does not perform 
the actual deletion of the successfully backed up transaction log extents, since the Domino 
Server manages when a transaction log extent is actually recycled. 
6 NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Backup Operations 
Backup Operations 
This section presents overview information on NetBackup for Lotus Notes for UNIX 
backup operations. 

Methods 
NetBackup provides three methods to perform backups: automatic, manual, and 
user-directed. This section contains an overview of these methods. For more information 
on these backup methods and other administrator-directed activities, refer to the 
NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup System 
Administrator’s Guide for UNIX, Volume I. 

Automatic Backups 

The NetBackup administrator can schedule backups that occur automatically and 
unattended, under the control of the NetBackup master server. Automatic backups will 
meet most of your backup requirements. 

Manual Backups 

The manual backup allows the administrator to initiate a full backup, 
cumulative-incremental backup or differential-incremental backup that has been set up in 
the policy manager. The manual backup option can be useful for the following situations: 

◆ Testing a configuration 

◆ When workstations miss their regular backups 

◆ Before installing new software (to preserve the old configuration) 

◆ Preserving records before a special event such as when companies split or merge 

In some cases, it may be useful to create a policy and schedule that you use only for 
manual backups. You can do this by creating a policy with a single schedule that has no 
backup window defined (and therefore never executes automatically). 

User-Directed Backups 

User-directed backups require a User Backup schedule type to be defined in the 
Lotus-Notes policy. Performing user-directed backups of Lotus databases is similar to 
using the Backup, Archive, and Restore interface to back up normal files. The example 
described in “Performing a Backup” on page 58 uses the Backup, Archive, and Restore 
interface to perform an online backup of a Lotus database. 
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Backup Operations 
Actions performed for a user backup of Lotus databases and transaction log extents are 
identical to a full backup except that the transaction log extents are not marked as ready to 
be recycled after they are successfully backed up. Because transaction log extents are not 
recycled, user backups are like taking a snapshot of the databases at a given point in time 
without impacting the content of ongoing full and incremental backups. A user backup is 
not automatically scheduled and must be initiated on the target client machine. 
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Restore and Recovery Operations 
Restore and Recovery Operations 
Using a few simple operations, an administrator using the NetBackup client can browse 
NetBackup for Lotus Notes backups and select the ones to be restored and recovered. 

NetBackup for Lotus Notes for UNIX will support both restore and recovery operations. 
A restore operation will allow a user to restore any previously backed up Lotus databases. 
The operations performed during a database restore are: 

◆ the existing database is taken offline and deleted 

◆ the database is restored 

◆	 changed records recorded during the backup of the database are restored and applied 
to the database, and if the database is unlogged or local the database is brought back 
online 

If the database is a logged database, the database name is added to a list for recovery 
after all databases (unlogged/local and logged) have been restored. 

Following the restore operation, the recovery operation will begin automatically and will 
attempt to recover all logged databases restored during the restore operation. The logged 
databases that have been restored will be rolled forward to a specific point in time using 
the appropriate transactions from the required transaction logs, before being brought back 
online. As part of the recovery operation, any required transaction logs that have been 
previously backed up and recycled will be restored automatically as part of the recovery 
operation. In general, it is recommended that required transaction log extents be restored 
automatically as part of the recovery operation rather than being restored manually by the 
user. 

Methods 
NetBackup provides three methods to perform restores: 

◆ server-directed 

◆ redirecting a restore to a different client 

◆ redirecting a restore to a different path 

These methods are supported in the Restore and Recovery Operations. An overview of 
these methods is given in the following sections. For more information on these restore 
methods and other administrator-directed activities, refer to the NetBackup System 
Administrator’s Guide for UNIX, Volume I, or NetBackup System Administrator’s Guide for 
Windows, Volume I. 
Chapter 1, Introduction 9 
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Restore and Recovery Operations 
Server-Directed Restore 

An administrator can browse NetBackup for Lotus Notes databases and select the ones to 
be restored. When the administrator initiates the restore, the request is passed from the 
client to the NetBackup master server. Once the server validates the request, the restore 
operation becomes fully managed by the server, which identifies the storage device and 
the volume containing the Lotus databases by querying the NetBackup database. The 
server then transmits the data back to the client. 

NetBackup restores Lotus databases and transaction log extents from a range of backups. 
By default, this range includes the last full backup and all cumulative incremental 
backups or differential incremental backups since that full backup. 

NetBackup will allow you to select the NetBackup server from which files will be 
restored, to view the backup history, and to select items to restore for: 

◆ a specific client 

◆ other clients that were backed up by the selected NetBackup server 

Redirecting a Restore to a Different Client 

Databases or directories can be restored to a client other than the one from which they 
were backed up. This is possible only if the NetBackup administrator sets up the 
configuration to allow it and the NetBackup for Lotus Notes for UNIX agent has been 
installed on the alternate client. The administrator using the NetBackup Administration 
Console on the master server or using the Remote Administration Console can direct 
restores to any NetBackup client (regardless of which client the files came from). Please 
see the appropriate NetBackup manuals for the configuration needed for this type of 
redirected restore. 

Redirecting a Restore to a Different Path 

A user can restore Lotus database files to directories that are different from the directories 
from which the databases were backed up. 
10 NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Installation 
2


This chapter describes the requirements for using NetBackup for Lotus Notes for UNIX 
and how it is installed. 

To determine which Lotus version levels are supported, refer to the Database Agent 
Matrix in the NetBackup Release Notes for UNIX and Windows. 
11 
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Requirements 
Requirements 
For backup operations, the following requirements must be met: 

◆	 Lotus Domino Server R5.0.3, or later, or R6.0.2 or later must be installed on the 
NetBackup client before a backup operation can be performed. 

◆	 Transaction logging must be enabled in order to initiate the recovery of logged 
databases. 

For restore and recovery operations, the following requirement must be met: 

◆	 Transaction logging must be enabled in order to implement the recovery of logged 
databases. 

Installation Prerequisites 
Before installing NetBackup for Lotus Notes for UNIX, be sure you have completed the 
following procedures: 

❖ Install the NetBackup server software on the server. 

The NetBackup server platform can be any of those that NetBackup supports. 

Refer to the NetBackup Installation Guide for UNIX or the NetBackup Installation Guide 
for Windows. 

❖	 Install the NetBackup client software on the client where you will be backing up the 
Lotus databases. 

Refer to the NetBackup Installation Guide for UNIX for installation instructions. 

Now you are ready to install NetBackup for Lotus Notes for UNIX on the client where you 
will be backing up the Lotus databases. Refer to the next section for detailed instructions 
on installing NetBackup for Lotus Notes for UNIX. 
12 NetBackup for Lotus Notes System Administrator’s Guide for UNIX 
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Installation Prerequisites 
Guidelines for Installing NetBackup for Lotus Notes for UNIX 
in a Cluster 

◆	 Prior to installing NetBackup for Lotus Notes for UNIX, the NetBackup server must 
be installed and configured to work in a cluster. (This is accomplished by following 
the instructions in the NetBackup Installation Guide for UNIX, including running the 
cluster_config script after the NetBackup server software has been installed.) 

◆	 Commands such as bpplclients and update_dbclients must be run from the 
active NetBackup node. If you are pushing the database agent software to clients 
located in a cluster, specify the individual node names (not virtual names) in the list of 
clients. 

◆	 If installing NetBackup for Lotus Notes for UNIX on a clustered NetBackup server, 
freeze the active NetBackup node before beginning the installation. Install on all the 
inactive nodes, then install on the active node. After you successfully install on the 
active node, unfreeze this node. 

◆	 The cluster_config script only needs to be run after the NetBackup server 
software has been installed. You do not need to run this script after installing 
NetBackup for Lotus Notes for UNIX on a NetBackup server or if you wish to install 
NetBackup for Lotus Notes for UNIX on a machine on which only the NetBackup 
client is installed. 
Chapter 2, Installation 13 



NetBackup_AdminGuide_LotusNotes_Unix.book  Page 14  dnesday, April 28, 2004  2:31 PMWe

Installing NetBackup for Lotus Notes for UNIX 
Installing NetBackup for Lotus Notes for UNIX 
There are two ways to install database agent software. 

◆	 Remote Installation - Loads the software on a master server. The user will then push 
the database software out to affected clients. 

Refer to the following section. 

◆ Local Installation - Loads and installs the software only to the local machine. 

Refer to “Local Installation of NetBackup for Lotus Notes for UNIX” on page 19. 

Remote Installation of NetBackup for Lotus Notes for UNIX 
During a remote installation, NetBackup for Lotus Notes for UNIX files are loaded onto 
the current machine, which must be a UNIX master server. The software will then be 
distributed to the clients and installed. 

Note	 In a clustered environment, the capability to push client software is only available 
from the active node. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for Lotus Notes for 
UNIX must be the same (e.g., 5.1). 

◆ There must be adequate disk space on each client that will receive the software. 

Less than one megabyte of additional disk space is required in the client's 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆	 NetBackup version 5.1 client software is installed and operational on each Lotus 
Domino Server or Lotus Notes client. 

This also means that the directory install_path/netbackup already exists on 
each Lotus Domino Server or Lotus Notes client. 

◆	 Lotus Domino has been installed on each client to which you will be pushing 
NetBackup for Lotus Notes for UNIX software. 

◆	 In a clustered environment, NetBackup server has been installed and configured to 
work in a cluster. (This is accomplished by following the instructions in the NetBackup 
Installation Guide for UNIX, including running the cluster_config script after the 
NetBackup server software is installed.) 
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Installing NetBackup for Lotus Notes for UNIX 
Remote Installation Instructions 

▼ To perform a remote installation 

1.	 If installing NetBackup for Lotus Notes for UNIX on a clustered NetBackup server, 
first refer to the “Guidelines for Installing NetBackup for Lotus Notes for UNIX in a 
Cluster” earlier in this chapter. 

2.	 Log in as the root user on the server. 

If you are already logged in, but are not the root user, execute the following command. 

su - root


3.	 Make sure a valid license key for NetBackup for Lotus Notes has been registered. To 
view or add license keys, perform one of the following: 

◆ Run the following command: 

install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

4. Insert the CD-ROM into the drive. 

5.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

6.	 Load the software on the server by executing the install script. 

./install 

a.	 Select the NetBackup Database Agent Software option. 

The following prompt will appear: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer n. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for Lotus Notes option. 

d.	 Enter q to quit selecting options. 

A prompt will appear asking if the list is correct. 

e. Answer y. 
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Installing NetBackup for Lotus Notes for UNIX 
The install script identifies the types of client software loaded during the 
installation of the NetBackup server. By default, any matching NetBackup for 
Lotus Notes for UNIX software will automatically be loaded. If there are more 
platforms available, the script displays a menu giving you the opportunity to add 
more client types to the default list. Once the list is complete, database agent 
version files, compressed tar files and the install_dbext script are copied to 
directory install_path/netbackup/dbext. 

f. Enter q to quit from the script. 

7.	 Distribute and install the NetBackup for Lotus Notes for UNIX software on each client 
as described in the next sections. 

Note	 In a clustered environment, the capability to distribute client software is only 
available from the active node. 

There are two types of installs. 

◆	 initial install — Use an initial install if the clients you intend to update have not 
been added to policies of type Lotus-Notes. 

◆	 upgrade install — Use an upgrade install if all the clients you intend to update 
already have been added to policies of type Lotus-Notes. 

Note	 The NetBackup version level (for example, 5.1) running on the clients you wish to 
update must be the same as the version level of the NetBackup for Lotus Notes for 
UNIX being installed. 

Initial Installation on Clients 

▼ To perform an initial install on the clients 

1.	 Execute the following command to create a file containing a list of clients currently 
configured in the NetBackup database. 

cd install_path/netbackup/bin

./admincmd/bpplclients -allunique -noheader > filename


where filename is the name of the file to contain the list of unique clients. If no 
clients have been configured in the NetBackup database, and therefore filename is 
empty, create filename using the same format as that generated by bpplclients. 

bpplclients generates output in following format: 

hardware operating_system client_name 
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Installing NetBackup for Lotus Notes for UNIX 
where: 

hardware is the hardware name. For example, execute the ls command in 
directory install_path/netbackup/client. 

operating_system is the operating system name. For example, execute the ls 
command in directory install_path/netbackup/client/hardware. 

client_name is the name of the client. 

For example, the contents of filename might look like this: 

Solaris Solaris8 curry

RS6000 AIX4.3.3 cypress

Linux RedHat2.4 bumper


2. Edit filename. 

This is an optional step. Use it if the contents of filename need to be changed. Edit 
filename to contain only those clients you wish to update with NetBackup for Lotus 
Notes for UNIX software. 

3. Specify filename on the update_dbclients command. 

For example: 

cd install_path/netbackup/bin

./update_dbclients Lotus_Notes -ClientList filename


Only clients listed in filename will be updated. 

Upgrade Installation on Clients 

▼ To perform an upgrade installation on the clients 

1. Execute the following command. 

cd install_path/netbackup/bin

./update_dbclients Lotus_Notes ALL ALL


This command will look at all possible clients and only update the ones currently in 
the Lotus-Notes policy type. 

Instead of ALL ALL, you may use -ClientList filename as explained in “Initial 
Installation on Clients” on page 16. 
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Installing NetBackup for Lotus Notes for UNIX 
Note	 With an initial or upgrade install, some clients may be skipped and not updated. 
Possible reasons are: 
- the client is a PC client (which cannot be updated from a UNIX server) 
- NetBackup for Lotus Notes for UNIX does not support that client's platform type 
- the NetBackup for Lotus Notes for UNIX software for that client type was not 

loaded onto the server in step 6 of the “Remote Installation Instructions” on page 15

- (if using the ALL ALL method) the client does not belong to the Lotus-Notes

policy type 

All skipped clients are available in a file whose name is displayed by

update_dbclients.


The number of updates required to distribute the software to the clients is displayed.


If more than one update will occur, you will see the following prompt:


Enter the number of simultaneous updates you wish to take place. 1 - max dflt


(must be in the range of 1 to max; default: dflt). 

where: 

max is the maximum number of simultaneous updates that is allowed. The value 
displayed will be a number ranging from 1 to 30. 

dflt is the default number the program will use if you press Enter. The value 
displayed will be a number ranging from 1 to 15. 

For example, if three client updates will be performed, the max and dflt values shown 
would be 3. If 50 client updates will be performed, the max value shown would be 30 
and the dflt value shown would be 15. 

update_dbclients will start the number of updates that you specify. If this number 
is less than the total number of client updates to be performed, new updates will start 
as the previous updates finish until all of the updates have been completed. 

Based on your answer, the time it will take to update the clients is displayed, followed 
by this question: 

Do you want to upgrade the clients now? (y/n) [y]


2. Enter y or n for the prompt. 

If you answer n, update_dbclients will quit and leave the list of clients it would 
have updated in a file. This file can later be used by the -ClientList parameter 
mentioned previously. 

Answer y to continue the installation process. 

If the update_dbclients command was successful in distributing the software to the 
client, it will automatically run the install_dbext script on the client. If 
install_dbext has successfully completed, there will be a version file in directory 
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install_path/share that contains the version of NetBackup for Lotus Notes for UNIX 
that was installed. The update_dbclients command displays a note on whether the 
update was successful for each client. When the update_dbclients command has 
completed, it displays a file name that contains a complete log of what happened for each 
client. If the update failed for any client, the log file should be examined to determine the 
problem. 

Local Installation of NetBackup for Lotus Notes for UNIX 
During a local installation, the NetBackup for Lotus Notes for UNIX files are extracted 
and installed. The local machine can be a client or a master server that also happens to be 
a client. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for Lotus Notes for 
UNIX are the same (e.g., 5.1). 

◆ The local machine must have adequate disk space. 

Less than one megabyte of additional disk space is required in the 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆ NetBackup version 5.1 client software is installed and operational. 

This also means that the install_path/netbackup directory already exists. 

◆ Lotus Domino has been installed on the local machine. 

Local Install Instructions 

▼ To install NetBackup for Lotus Notes for UNIX to the local machine 

1.	 Log in as the root user on the machine. 

If you are already logged in, but are not the root user, execute the following command. 

su - root


◆ If the local machine is a client, go to step 3. 

◆ If the local machine is a server, go to step 2. 
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2.	 Make sure a valid license key for NetBackup for Lotus Notes has been registered. In a 
NetBackup server clustered environment, the license key must be registered on each 
node. To view or add license keys, perform one of the following: 

◆	 Run the command 
install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

3. Insert the CD-ROM into the drive. 

4.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

5. Load and install the software by executing the install script. 

Note	 It is expected that the NetBackup version level (for example, 5.1) running on the 
local machine matches the version level of the database agent being installed. 

./install


a.	 Select the NetBackup Database Agent Software option. 

The following prompt will appear: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer y. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for Lotus Notes option. 

d.	 Enter q to quit selecting options. 

A prompt will appear asking if the list is correct. 
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e. Answer y. 

The following actions will occur: 

◆	 The version file, compressed tar file and install_dbext script will be 
loaded to directory install_path/share. 

◆ The install script will automatically execute the install_dbext script. 

◆	 If install_dbext has successfully completed, there will be a version file in 
directory install_path/share that contains the version of NetBackup for 
Lotus Notes for UNIX that was installed. 

f. Enter q to quit from the script. 
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3	

This section provides an overview of how to configure NetBackup to perform backup and 
restore operations for Lotus databases and transaction log extents. 

To use NetBackup for Lotus Notes for UNIX, you must add at least one Lotus-Notes 
policy to NetBackup, then define the appropriate schedules for that policy. You must also 
configure NetBackup to perform backup and restore operations for individual mailboxes 
and folders. 

This chapter contains information on the following topics: 

◆ Defining the Client Properties for a Lotus Notes Client 

◆ Configuration Using the NetBackup Administration Console for Windows 

◆ Configuring a NetBackup Policy 

◆ Testing NetBackup for Lotus Notes for Windows Configuration Settings 

◆ Defining the Client Properties for a Lotus Notes Client 

◆ Configuration Using the NetBackup Administration Console for UNIX 

◆ Configuring a NetBackup Policy 

◆ Testing NetBackup for Lotus Notes for UNIX Configuration Settings 

Most requirements for Lotus-Notes policies are the same as for file system backups. Refer 
to the NetBackup System Administrator’s Guide for UNIX, Volume I or NetBackup System 
Administrator’s Guide for Windows, Volume 1, for detailed configuration instructions. 
23 



NetBackup_AdminGuide_LotusNotes_Unix.book  Page 24  dnesday, April 28, 2004  2:31 PMWe

Defining the Client Properties for a Lotus Notes Client 
Defining the Client Properties for a Lotus Notes Client 
NetBackup for Lotus Notes for UNIX needs to know: 

◆ the path where the Lotus Domino data directory is located 

◆ where the Lotus program files reside 

◆ the location of the Lotus Domino resource files 

◆ the path to the Lotus notes.ini file 

NetBackup for Lotus Notes for UNIX will look for the above in the path defined in the 
LOTUS_NOTES_PATH variable. If the notes.ini file is located in a directory other 
than that defined in the LOTUS_NOTES_PATH, you can specify the path in the 
LOTUS_NOTES_INI variable. If the Lotus program files are located in a directory other 
than that defined in the LOTUS_NOTES_PATH, you can specify the path in the 
LOTUS_NOTES_EXECDIR variable. 

These variables can be set in the Client properties for the client or in the bp.conf file. 

Defining the Lotus Notes Variables in the Client Properties 

▼ To define the Lotus Notes variables 

1. Open the NetBackup Administration Console. 

2. Expand Host Properties. 

3. Click on Clients. 

4. In the right pane, right-click on the client and click Properties. 
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5. In the left pane, expand Windows Client or UNIX Client and click Lotus Notes. 

6.
 In the Path box, specify a path made up of the Domino data directory, the Lotus 
program directory, and the Lotus resource directory. For example: 

/export/home/notesdata:/opt/lotus/notes/latest

/sunspa:/opt/lotus/notes/latest/sunspa/res/C


7.
 To specify a Lotus notes.ini in an alternate directory than those specified in Path, 
specify the alternate Lotus notes.ini in the INI Path box. For example: 

/db/notesdata/notes.ini


8.
 To specify an alternate Lotus program files directory other than specified in the Path 
directory, specify the directory in the Executable Directory box. For example: 

/opt/lotus/notes/latest/sunspa


NetBackup for Lotus Notes for UNIX will now look for the Lotus program files in the 
LOTUS_NOTES_EXECDIR directory, rather than in the LOTUS_NOTES_PATH 
directory. 

9. Click OK to save your changes. 
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Defining the Lotus Notes Variables in the bp.conf File 
The LOTUS_NOTES_PATH, LOTUS_NOTES_INI and LOTUS_NOTES_EXECDIR 
variables can also be defined in the bp.conf file. 

▼ To define the Lotus Notes variables 

1.
 Open the bp.conf file. 

This file is located in install_path/netbackup/. 

2. To define the Lotus Notes path, add a LOTUS_NOTES_PATH entry, for example: 

LOTUS_NOTES_PATH = /export/home/notesdata:/opt/lotus/notes/latest 

/sunspa:/opt/lotus/notes/latest/sunspa/res/C


3.
 To specify a Lotus notes.ini in an alternate directory than those specified in 
LOTUS_NOTES_PATH, add a LOTUS_NOTES_INI entry that defines where the 
alternate Lotus notes.ini file resides. For example: 

LOTUS_NOTES_INI = /db/notesdata/notes.ini


4.
 To specify an alternate Lotus program files directory than the directory specified in 
LOTUS_NOTES_PATH, add a LOTUS_NOTES_EXECDIR entry that defines where the 
alternate Lotus program files reside. For example: 

LOTUS_NOTES_EXECDIR = /opt/lotus/notes/latest/sunspa
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Configuration Using the NetBackup Administration 
Console for UNIX 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for Lotus Notes for UNIX configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for UNIX 

1. Log onto the UNIX server as root. 

2.
 Start the NetBackup Administration Console by executing: 

install_path/netbackup/bin/jnbSA & 

The login dialog is displayed. 

3.
 Type the name of the master server where you initially want to manage NetBackup. 
You can specify any NetBackup master server that has a valid license key for 
NetBackup for Lotus Notes registered. Indicate the User and Password. 
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4. Click Login. The NetBackup Administration Console is displayed. 

Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ policy attributes 

◆ backup schedules 

◆ items to be backed up, including a list of databases and directives 

◆ clients to be backed up 

To use NetBackup for Lotus Notes for UNIX, at least one Lotus-Notes policy with the 
appropriate schedules needs to be defined. A configuration can have a single policy that 
includes all clients or there can be many policies, some of which include only one client. 
28 NetBackup for Lotus Notes System Administrator’s Guide for UNIX 



NetBackup_AdminGuide_LotusNotes_Unix.book  Page 29  dnesday, April 28, 2004  2:31 PMWe

Configuration Using the NetBackup Administration Console for UNIX 
Most requirements for Lotus-Notes policies are the same as for file system backups. In 
addition to the attributes described here, there are other attributes for a policy to consider. 
Refer to the NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup 
System Administrator’s Guide for UNIX, Volume I for detailed configuration instructions and 
information on all the attributes available. 

Adding New Policies 

Use this procedure when configuring a policy from a UNIX server. 

▼ To add a new policy 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.
 If your site has more than one master server, choose the one to which you want to add 
the policy. 

4.
 In the left pane, click on Policies. The right pane splits into an All Policies pane and a 
details pane. 

5.
 In the All Policies pane, right-click on the Master Server, and click New. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.
 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 
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◆	 To use the wizard, select the Use add policy wizard box and click OK. The 
wizard starts and you create the policy by following the prompts. When 
prompted, select the Lotus-Notes policy type. 

Note
 The Lotus-Notes policy type will not appear in the drop-down list unless your 
server has a license key for NetBackup for Lotus Notes. 

◆	 If you require more control over the settings than the wizard provides, do not 
select the Use add policy wizard box and proceed to step 6. 

6.
 Click OK. 

A dialog is displayed in which you can specify the general attributes for the policy. 

7. From the Policy type box, select the Lotus-Notes policy type. 
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8.
 Complete the entries on the Attributes tab as explained in “Description of Attributes” 
and click Apply to save the attribute entries. 

9. Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆	 To add to the list of Backup Selections, see “Adding New Backup Selections” on 
page 36. 

10. Click Apply. The new policy is created. 

Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for Lotus backups are explained below. This 
information is used when you are adding a new policy using either a Windows server 
(refer to “Adding New Policies” on page 41) or a UNIX server (refer to “Adding New 
Policies” on page 29). 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for Lotus Notes for UNIX, you must have defined at 
least one Lotus-Notes policy. 

Keyword phrase to A textual description of a backup. Useful for browsing backups and

associate with the restores.

backup


Allow multiple data 
streams 

Specifies that, depending on directives in the list of backup selections, 
NetBackup can divide automatic backups for each client into multiple jobs, 
with each job backing up only a part of the list of backup selections. The 
jobs are in separate data streams and can occur concurrently. The number 
of available storage units, multiplex settings, and the maximum jobs 
parameters determines the total number of streams and how many can run 
concurrently. 
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Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

The following procedure starts from the Policy dialog. To see the Policy dialog, double 
click the policy name in the policy list in the left pane of the NetBackup Administration 
Console. 

▼ To add a schedule 

1. In the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of backup. 

For information on the types of backups available for this policy, see “Types of 
Backups” on page 34. 
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5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. If this is the last schedule, click OK. 

To add more schedules, click Add and repeat step 2 through step 5. Click Close to 
cancel changes that you have not yet added and close the dialog. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained below. This information is used 
when you are adding a new schedule using either a Windows server (refer to “Adding 
New Schedules” on page 44) or a UNIX server (refer to “Adding New Schedules” on 
page 32). 

Other schedule properties will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 

Retention	 Specifies a retention period for keeping backup copies of files before 
deleting them.  Set the time period to retain at least two full backups of your 
database. In this way, if one full backup has been lost, you will have another 
full backup to fall back on. For example, if your database is backed up once 
every Sunday morning, you should select a retention period of at least 2 
weeks. 
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Types of Backups 

This information is used when you are adding a new schedule using either a Windows 
server (refer to “Adding New Schedules” on page 44) or a UNIX server (refer to “Adding 
New Schedules” on page 32). 

The types of backups that can be performed are described in the following table: 

Description of Types of Backups 

Type of Backup Description 

Full backup	 This backup type is used to back up all the Lotus databases identified in the 
Backup Selections list and/or the available transaction logs extents, if the 
BACKUP_TRANSACTION_LOGS directive is specified in the Backup 
Selections list. All transaction log extents, identified as available for backup 
by the Domino Server will be backed up. The inactive transaction log extents 
will be marked as ready to be recycled after they are successfully backed up. 
The Domino Server handles the actual recycling of transaction log extents. 

Differential- A differential-incremental backup will perform differently depending on the 
incremental backup type of Lotus database encountered. 

◆ unlogged databases or local databases 

A differential-incremental backup will back up all unlogged or local 
databases identified in the Backup Selections list that have been 
modified since the last full or incremental backup. The last modification 
date is determined by the time the database was last modified, not the 
time/date stamp of the database file. 

◆ logged databases (archival-style logging enabled) 

A differential-incremental backup will back up only those logged 
databases identified in the Backup Selections list that have been assigned 
a new DBIID since the last full or incremental backup. 

◆ logged databases (circular-style and linear- logging enabled) 

A differential-incremental backup will back up all logged databases 
identified in the Backup Selections list that have been modified since the 
last full or incremental backup. The last modification date is 
deterrmined by the time the database was last modified, not the 
time/date stamp of the database file. 

◆ transaction logs 

When the BACKUP_TRANSACTION_LOGS directive is encountered in the 
Backup Selections list, a differential-incremental backup will back up all 
transaction log extents identified as available for backup by the Domino 
Server. The inactive transaction log extents that are backed up will be 
marked as ready to be recycled upon successful completion of the 
backup. 
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Description of Types of Backups 

Type of Backup Description 

Cumulative-
Incremental backup 

User backup 

A cumulative-incremental backup will perform differently depending on 
the type of Lotus database encountered. 

◆ unlogged databases or local databases 

A cumulative-incremental backup will backup all unlogged or local 
databases identified in the Backup Selections list that have been 
modified since the last full backup. The last modification date is 
determined by the time the database itself was modified, not the 
time/date stamp of the database file. 

◆ logged databases (archival-style logging enabled) 

A cumulative-incremental backup will backup only those logged 
databases identified in the Backup Selections list that have been assigned 
a new DBIID since the last full backup. 

◆ logged databases (circular- and linear-style logging enabled) 

A cumulative-incremental backup will back up all logged databases 
identified in the Backup Selections list that have been modified since the 
last full or incremental backup. The last modification date is 
deterrmined by the time the database was last modified, not the 
time/date stamp of the database file. 

◆ transaction logs 

When the BACKUP_TRANSACTION_LOGS directive is specified in the 
Backup Selections list, a cumulative-incremental backup will back up all 
transaction log extents identified as available for backup by the Domino 
Server. The transaction log extents will not be marked as ready to be 
recycled upon successful completion of the backup. 

Actions performed for a user backup are identical to a full backup except 
that the transaction log extents are not marked as ready to be recycled after 
they are successfully backed up. Because transaction log extents are not 
recycled, user backups are like taking a snapshot of the databases and 
transaction log extents at a given point in time without impacting the 
content of ongoing full and incremental backups. 

A user backup is not automatically scheduled and must be initiated on the 
target client machine. 

You may want to consider creating a separate policy for User Backup 
schedule types. This will allow you to easily separate user-directed and 
scheduled backups when restoring files. If you decide to create separate 
policies for User Backup schedule types, the considerations are similar to 
those for automatic backups. One difference is that you do not need a to 
indicate any backup selections because users select the files before starting 
the operation. 
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Adding New Backup Selections 

The following procedures explain how to add databases or directives to the Backup 
Selections list. Only the databases and/or directives specified will be backed up. The 
procedure assumes you have the Policy dialog open. To see the Policy dialog, double-click 
the policy name in the Policies list in the NetBackup Administration Console. 

▼ To add databases or directives to the Backup Selections List 

1. In the Policy dialog, click Backup Selections. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding backup selections. 

3. Indicate what you wish to back up. 

◆	 To specify a directory or database in the Backup Selections list, type the name of 
the directory or database in the Pathname or directive text box and click Add. 

◆	 To specify a directive, click the arrow button to the right of the Pathname or 
directive box, select a directive, and click Add. 

For information about the directives, refer to the “Directives in the Backup 
Selections List” section. 
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4. If there are no more items to add, click OK. 

Any pathnames or directives you specified are appended to the end of the Backup 
Selections list. 

Directives in the Backup Selections List 

This information is used when you are adding Lotus Notes directives to the Backup 
Selections list using either a Windows server (refer to “Adding New Backup Selections” 
on page 49) or a UNIX server (refer to “Adding New Backup Selections” on page 36). 

The types of directives that can be added to the Backup Selections list are described in the 
following table: 

Directives in the Backup Selections List 

Directive Description 

ALL_LOTUS_DATABASES This directive is supported only on UNIX clients. 

Performs the backup on all Lotus databases on each of the 
selected clients. ALL_LOTUS_DATABASES means both local 
databases and Domino Server databases. 

Note Using the ALL_LOTUS_DATABASES Backup Selections 
list directive can have tremendous performance issues 
on clients with large or multiple local drives. In this case, 
it is suggested that more specific folders or databases be 
added to the Backup Selections list, for example, the 
Domino data directory. 

BACKUP_TRANSACTION_LOGS	 Backs up all transaction log extents identified by the Domino 
Server as available for backup. 

NOTES_INI_PATH=	 If you are configuring a backup for a Domino partitioned 
server, use this directive, where: 

NOTES_INI_PATH= the absolute path for the notes.ini file 
associated with the server instance to be used 

This directive identifies the location of the notes.ini file 
associated with the particular server partition that will be used 
to perform the backup. The server partition specified will have 
an impact on the how a database is backed up (logged or 
unlogged) and which set of transaction log extents will be 
backed up. 
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Directives in the Backup Selections List 

Directive Description 

NEW_STREAM	 To perform a scheduled backup of more than one partition for 
Domino partitioned server from a single policy, you must back 
up each Domino partition with a separate data stream. Use the 
NEW_STREAM directive and the appropriate 
NOTES_INI_PATH= directive for each data stream. 

The NEW_STREAM directive is used to define a single stream 
for a particular partition of a Domino partitioned server, and 
multiple streams for a single partition on a non-partitioned 
Domino Server. 

To use the NEW_STREAM directive, the Allow multiple data 
streams attribute must be enabled for the policy on the 
Attributes tab. 

For more information on the NEW_STREAM directive, see the 
NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I. 

ALL_LOTUS_DATABASES Directive 

The ALL_LOTUS_DATABASES directive is not supported for Windows clients. If this 
directive is encountered when performing a Lotus-Notes backup on a Windows client, the 
backup will fail with a status 69: The file list string is invalid. 

On your NetBackup master server(s), review each Lotus-Notes policy. 

◆	 If the ALL_LOTUS_DATABASES directive does not appear in any Lotus-Notes policy, 
no action is necessary. 

◆	 If only UNIX clients are specified in the client list for the Lotus-Notes policy 
containing the ALL_LOTUS_DATABASES directive, no action is necessary. 

◆	 If only Windows clients are specified in the client list for the Lotus-Notes policy 
containing the ALL_LOTUS_DATABASES directive, remove the directive from the 
Backup Selections list and add entries for the folder(s) containing the actual Lotus 
database(s). 

◆	 If both UNIX and Windows clients are specified in the client list for the Lotus-Notes 
policy containing the ALL_LOTUS_DATABASES directive, separate the policy into 
two policies: one exclusively for UNIX clients and another exclusively for Windows 
clients. Remove the ALL_LOTUS_DATABASES directive from the policy for the 
Windows clients and add entries for the folder(s) containing the actual Lotus 
database(s). 
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Adding Clients to a Policy 

The client list is the list of clients that will be backed up during an automatic backup. A 
NetBackup client must be in at least one policy but can be in more than one. 

This procedure starts from the Policy dialog. To see the Policy dialog, double-click the 
policy in the policy list in the left pane of the NetBackup Administration Console. 

Requirements for clients 

On the client the following must be installed:


◆ the Lotus Domino Server or Lotus Notes client


◆ NetBackup client or server


◆ NetBackup for Lotus Notes for UNIX


▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. On the Clients tab, click New. 

The Add Client dialog is displayed. The title bar shows the name of the policy where 
you are adding clients. 

3. In the Client name text box, type the name of the client that you are adding. 

4. Choose the Hardware and operating system type and click Add. 

5.
 If this is the last client, click OK. If you are going to add more clients, repeat step 3 and 
step 4. 
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Configuration Using the NetBackup Administration 
Console for Windows 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for Lotus Notes for UNIX configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for Windows 

1. Log on to the server as administrator. 

2.
 Choose Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 

The NetBackup Administration Console is displayed. 
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Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ policy attributes 

◆ backup schedules 

◆ items to be backed up, including a list of databases and directives 

◆ clients to be backed up 

To use NetBackup for Lotus Notes for UNIX, at least one Lotus-Notes policy with the 
appropriate schedules needs to be defined. A configuration can have a single policy that 
includes all clients or there can be many policies, some of which include only one client. 

Most requirements for Lotus-Notes policies are the same as for file system backups. In 
addition to the attributes described here, there are other attributes for a policy to consider. 
Refer to the NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup 
System Administrator’s Guide for UNIX, Volume I for detailed configuration instructions and 
information on all the attributes available. 

Adding New Policies 

Use this procedure when configuring a policy from a Windows server or from a 
NetBackup Remote Administration Console host. 

▼ To add a new policy 

1. Log on to the server as administrator. 

2. Start the NetBackup Administration Console. 

3.
 If your site has more than one master server, choose the one where you want to add 
the policy. 

4.
 In the left pane, right-click Policies and choose New Policy. 

The Add a New Policy dialog is displayed. 
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a. In the Policy name box, type a unique name for the new policy. 

b.
 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 

◆	 To use the wizard, select the Use Backup Policy Configuration Wizard box 
and click OK. The wizard starts and you create the policy by following the 
prompts. When prompted, select the Lotus-Notes policy type. 

Note
 The Lotus-Notes policy type will not appear in the drop-down list unless your 
server has a license key for NetBackup for Lotus Notes. 

◆	 If you require more control over the settings than the wizard provides, then 
do not select the Use Backup Policy Configuration Wizard box and proceed 
to step 5. 

5.
 Click OK. 

A dialog is displayed in which you can specify the general attributes for the policy. 
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6. From the Policy Type box, select the Lotus-Notes policy type. 

7.
 Complete the entries on the Attributes tab as explained in “Description of 
Attributes.” 

8. Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆	 To add Lotus objects to the Backup Selections list, see “Adding New Backup 
Selections” on page 49. 

9. Click OK. The new policy will be created. 
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Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for Lotus backups are explained below. This 
information is used when you are adding a new policy using either a Windows server 
(refer to “Adding New Policies” on page 41) or a UNIX server (refer to “Adding New 
Policies” on page 29). 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes�

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for Lotus Notes for UNIX, you must have defined at 
least one Lotus-Notes policy. 

Keyword phrase to A textual description of a backup. Useful for browsing backups and

associate with the restores.

backup


Allow multiple data 
streams 

Specifies that, depending on directives in the list of backup selections, 
NetBackup can divide automatic backups for each client into multiple jobs, 
with each job backing up only a part of the list of backup selections. The 
jobs are in separate data streams and can occur concurrently. The number 
of available storage units, multiplex settings, and the maximum jobs 
parameters determines the total number of streams and how many can run 
concurrently. 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

The following procedures start on the Policy dialog. To see the Policy dialog, double-click 
the policy name in the Policies list of the NetBackup Administration Console. 
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▼ To add a schedule 

1. On the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of backup. 

For information on the types of backups available for this policy, see “Types of 
Backups” on page 34. 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6.
 Click OK. 

To add other schedules, repeat step 1 through step 6. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained below. This information is used 
when you are adding a new schedule using either a Windows server (refer to “Adding 
New Schedules” on page 44) or a UNIX server (refer to “Adding New Schedules” on 
page 32). 
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Other schedule properties will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 

Retention	 Specifies a retention period for keeping backup copies of files before 
deleting them. Set the time period to retain at least two full backups of your 
database. In this way, if one full backup has been lost, you will have another 
full backup to fall back on. For example, if your database is backed up once 
every Sunday morning, you should select a retention period of at least 2 
weeks. 

Types of Backups 

This information is used when you are adding a new schedule using either a Windows 
server (refer to “Adding New Schedules” on page 44) or a UNIX server (refer to “Adding 
New Schedules” on page 32). 
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The types of backups that can be performed are described in the following table: 

Description of Types of Backups 

Type of Backup Description 

Full backup	 This backup type is used to back up all the Lotus databases identified in the 
Backup Selections list and/or the available transaction logs extents, if the 
BACKUP_TRANSACTION_LOGS directive is specified in the Backup 
Selections list. All transaction log extents, identified as available for backup 
by the Domino Server will be backed up. The inactive transaction log extents 
will be marked as ready to be recycled after they are successfully backed up. 
The Domino Server handles the actual recycling of transaction log extents. 

Differential- A differential-incremental backup will perform differently depending on the 
incremental backup type of Lotus database encountered. 

◆ unlogged databases or local databases 

A differential-incremental backup will back up all unlogged or local 
databases identified in the Backup Selections list that have been 
modified since the last full or incremental backup. The last modification 
date is determined by the time the database was last modified, not the 
time/date stamp of the database file. 

◆ logged databases (archival-style logging enabled) 

A differential-incremental backup will back up only those logged 
databases identified in the Backup Selections list that have been assigned 
a new DBIID since the last full or incremental backup. 

◆ logged databases (circular-style and linear- logging enabled) 

A differential-incremental backup will back up all logged databases 
identified in the Backup Selections list that have been modified since the 
last full or incremental backup. The last modification date is 
deterrmined by the time the database was last modified, not the 
time/date stamp of the database file. 

◆ transaction logs 

When the BACKUP_TRANSACTION_LOGS directive is encountered in the 
Backup Selections list, a differential-incremental backup will back up all 
transaction log extents identified as available for backup by the Domino 
Server. The inactive transaction log extents that are backed up will be 
marked as ready to be recycled upon successful completion of the 
backup. 
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Description of Types of Backups 

Type of Backup Description 

Cumulative-
Incremental backup 

User backup 

A cumulative-incremental backup will perform differently depending on 
the type of Lotus database encountered. 

◆ unlogged databases or local databases 

A cumulative-incremental backup will backup all unlogged or local 
databases identified in the Backup Selections list that have been 
modified since the last full backup. The last modification date is 
determined by the time the database itself was modified, not the 
time/date stamp of the database file. 

◆ logged databases (archival-style logging enabled) 

A cumulative-incremental backup will backup only those logged 
databases identified in the Backup Selections list that have been assigned 
a new DBIID since the last full backup. 

◆ logged databases (circular- and linear-style logging enabled) 

A cumulative-incremental backup will back up all logged databases 
identified in the Backup Selections list that have been modified since the 
last full or incremental backup. The last modification date is 
deterrmined by the time the database was last modified, not the 
time/date stamp of the database file. 

◆ transaction logs 

When the BACKUP_TRANSACTION_LOGS directive is specified in the 
Backup Selections list, a cumulative-incremental backup will back up all 
transaction log extents identified as available for backup by the Domino 
Server. The transaction log extents will not be marked as ready to be 
recycled upon successful completion of the backup. 

Actions performed for a user backup are identical to a full backup except 
that the transaction log extents are not marked as ready to be recycled after 
they are successfully backed up. Because transaction log extents are not 
recycled, user backups are like taking a snapshot of the databases and 
transaction log extents at a given point in time without impacting the 
content of ongoing full and incremental backups. 

A user backup is not automatically scheduled and must be initiated on the 
target client machine. 

You may want to consider creating a separate policy for User Backup 
schedule types. This will allow you to easily separate user-directed and 
scheduled backups when restoring files. If you decide to create separate 
policies for User Backup schedule types, the considerations are similar to 
those for automatic backups. One difference is that you do not need a to 
indicate any backup selections because users select the files before starting 
the operation. 
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Adding New Backup Selections 

The following procedures explain how to add databases or directives to the Backup 
Selections list. Only the databases and/or directives specified will be backed up. The 
procedures assume you have the Policy dialog open. To see the Policy dialog, double-click 
the policy name in the Policies list in the NetBackup Administration Console. 

▼ To add directives to the Backup Selections List 

1. In the Policy dialog, click Backup Selections. 

2. Click New. 

3. Click the Directives button. 

4.
 From the Directive list, select a directive. For a description of each of the directives, 
refer to “Directives in the Backup Selections List” on page 30. 

5. Click OK. 

6. If this is the last entry you wish to add click OK. 

▼ To add databases or folders to the Backup Selections List 

1. In the Policy dialog, click Backup Selections. 

2. Click New. 

3. Click the Remote Folder button. 

4. Browse to the database or folder you wish to add and select it. 
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5. Click OK. 

6. If this is the last entry you wish to add click OK. 

Directives in the Backup Selections List 

This information is used when you are adding Lotus Notes directives to the Backup 
Selections list using either a Windows server (refer to “Adding New Backup Selections” 
on page 49) or a UNIX server (refer to “Adding New Backup Selections” on page 36). 

The types of directives that can be added to the Backup Selections list are described in the 
following table: 

Directives in the Backup Selections List 

Directive Description 

ALL_LOTUS_DATABASES This directive is supported only on UNIX clients. 

Performs the backup on all Lotus databases on each of the 
selected clients. ALL_LOTUS_DATABASES means both local 
databases and Domino Server databases. 

Note Using the ALL_LOTUS_DATABASES Backup Selections 
list directive can have tremendous performance issues 
on clients with large or multiple local drives. In this case, 
it is suggested that more specific folders or databases be 
added to the Backup Selections list, for example, the 
Domino data directory. 
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Directives in the Backup Selections List 

Directive Description 

BACKUP_TRANSACTION_LOGS	 Backs up all transaction log extents identified by the Domino 
Server as available for backup. 

NOTES_INI_PATH=	 If you are configuring a backup for a Domino partitioned 
server, use this directive, where: 

NOTES_INI_PATH= the absolute path for the notes.ini file 
associated with the server instance to be used 

This directive identifies the location of the notes.ini file 
associated with the particular server partition that will be used 
to perform the backup. The server partition specified will have 
an impact on the how a database is backed up (logged or 
unlogged) and which set of transaction log extents will be 
backed up. 

NEW_STREAM	 To perform a scheduled backup of more than one partition for 
Domino partitioned server from a single policy, you must back 
up each Domino partition with a separate data stream. Use the 
NEW_STREAM directive and the appropriate 
NOTES_INI_PATH= directive for each data stream. 

The NEW_STREAM directive is used to define a single stream 
for a particular partition of a Domino partitioned server, and 
multiple streams for a single partition on a non-partitioned 
Domino Server. 

To use the NEW_STREAM directive, the Allow multiple data 
streams attribute must be enabled for the policy on the 
Attributes tab. 

For more information on the NEW_STREAM directive, see the 
NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I. 

ALL_LOTUS_DATABASES Directive 

The ALL_LOTUS_DATABASES directive is not supported for Windows clients. If this 
directive is encountered when performing a Lotus-Notes backup on a Windows client, the 
backup will fail with a status 69: The file list string is invalid. 

On your NetBackup master server(s), review each Lotus-Notes policy. 

◆	 If the ALL_LOTUS_DATABASES directive does not appear in any Lotus-Notes policy, 
no action is necessary. 

◆	 If only UNIX clients are specified in the client list for the Lotus-Notes policy 
containing the ALL_LOTUS_DATABASES directive, no action is necessary. 
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◆	 If only Windows clients are specified in the client list for the Lotus-Notes policy 
containing the ALL_LOTUS_DATABASES directive, remove the directive from the 
Backup Selections list and add entries for the folder(s) containing the actual Lotus 
database(s). 

◆	 If both UNIX and Windows clients are specified in the client list for the Lotus-Notes 
policy containing the ALL_LOTUS_DATABASES directive, separate the policy into 
two policies: one exclusively for UNIX clients and another exclusively for Windows 
clients. Remove the ALL_LOTUS_DATABASES directive from the policy for the 
Windows clients and add entries for the folder(s) containing the actual Lotus 
database(s). 

Adding Clients to a Policy 

The client list is the list of clients that will be backed up during an automatic backup. A 
NetBackup client must be in at least one policy but can be in more than one. 

This procedure starts in the Policy dialog. To see the Policy dialog, double-click the policy 
name in the Policies list in the NetBackup Administration Console. 

Requirements for clients 

On the client the following must be installed:


◆ the Lotus Domino Server or Lotus Lotus client


◆ NetBackup client or server


◆ NetBackup for Lotus Notes for UNIX


▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. Click New. 
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3. Enter the name of the client you want to add. 

◆ Type the name into the client list and click OK. 

If NetBackup cannot detect the hardware and operating system, a dialog will be 
displayed so you can specify this information. 

OR 

◆ Click the Browse for Computer button to choose the client from the network: 

4.
 To add another client, repeat step 2 and step 3. If this is the last client, click OK to 
close the dialog. 
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Testing NetBackup for Lotus Notes for UNIX Configuration 
Settings 

After you have configured the master server for NetBackup for Lotus Notes for UNIX, 
you should test the configuration settings. For a description of status codes, refer to the 
NetBackup Troubleshooting Guide for UNIX and Windows. 

NetBackup Administration Console for UNIX 
Use this procedure to test a policy configuration on the NetBackup Administration 
Console for UNIX. 

▼ To test the configuration settings on a UNIX server 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.
 In the left pane, click Policies. 

The right pane splits into an All Policies pane and a details pane. 

4. In the All Policies pane, click the policy you wish to test. 

5.
 Choose Actions > Manual Backup. 

The Manual Backup dialog is displayed. 
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The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 

7. Click Activity Monitor on the NetBackup Administration Console. 

If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 

NetBackup Administration Console for Windows 
Use this procedure to test a policy configuration from a Windows server or from the 
Remote Administration Console. 

▼ To test the configuration settings on a Windows server 

1. Log onto the server as administrator. 

2. Start the NetBackup Administration Console. 
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3. In the left pane, click Policies. The policy list appears in the right pane. 

4. Click on the policy you wish to test. 

5. Choose Actions > Manual Backup. 

The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 

7. Click Activity Monitor on the NetBackup Administration Console. 

If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 
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4	

After completing the configuration, you can use the Backup, Archive, and Restore 
interface to back up Lotus databases, mailboxes, transaction log extents, or folders. 
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Performing a Backup 
This section describes a user-directed backup of a Lotus database using NetBackup for 
Lotus Notes for UNIX. These instructions supplement the operating instructions in the 
NetBackup Backup, Archive, and Restore Getting Started Guide. Refer to that guide for detailed 
backup instructions. 

Note
 User-directed backups will not mark backed up transaction log extents as ready to 
be recycled upon successful completion of the backup. Therefore, user-directed 
backups should be used for special situations and should not replace regularily 
scheduled full or incremental backups. 

▼ To perform a backup 

1. Open the Backup, Archive, and Restore interface. 

2. Click the Backup Files tab. 

The Lotus Notes object is displayed in the left pane. Items within this object can be 
selected in order to perform backups of the logged and unlogged Domino Server 
databases, local databases, and archive style transaction log extents. 
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3. If necessary, change the NetBackup master server that will perform the backup. 

If there is more than one master server to which you can send your backups, ensure 
that you are connected to the correct one. Ask your NetBackup administrator if you 
have questions about which master server to use. 

Normally, you will not have to switch master servers unless, for some reason, the 
administrator has temporarily moved the NetBackup backups (for example, because 
of a problem on the original master server). If the change becomes permanent, the 
administrator should change your default to reflect the other server. 

4.
 To specify what you want to back up, expand the Lotus Notes object, navigate the 
directories, and select the desired databases, the Transaction Logs node, or both. 

Note
 It is not possible to select individual transaction log extents to be backed up. 
Instead, to backup transaction log extents, select the Transaction Log node of the 
tree. NetBackup will then query the Domino server for the list of transaction log 
extents that are available to be backed up. 

5. Click Backup. 
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The Backup Files dialog box is displayed. 

When backing up from a Domino partition server, you can specify the absolute path 
for the notes.ini file associated with the particular server partition that will be 
used to perform the backup. The server partition specified will have an impact on 
how a database is backed up (if logged) and which set of transaction logs will be 
backed up. 

6. Click Start Backup. 

Note The NetBackup operation may take a few minutes to complete. 
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Performing a Restore 
This section describes a user-directed restore of a Lotus database using NetBackup for 
Lotus Notes for UNIX. These instructions supplement the operating instructions in the 
NetBackup Backup, Archive, and Restore Getting Started Guide, to which you can refer for 
detailed restore instructions. 

▼ To perform a restore 

1. Open the Backup, Archive, and Restore interface. 

2.
 Log in as Domino Server administrative user. Performing a restore as the root user is 
not allowed. 

3. Click the Restore Files tab. 

4. Select the appropriate server, source client ,and policy type. 

a. On the Actions menu, click Specify NetBackup Machines and Policy Type. 

b.
 Verify that the appropriate server is marked as CURRENT. 

To change the server, select the desired server and click the Make Current. 

c. Click on the Source client/Policy type tab. 
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Performing a Restore 
d. Verify that the appropriate client is marked as CURRENT. 

The source client is the client on which the backup was performed. To change the 
source client, select the desired client and click the Make Current. 

e. From the Policy type list, select Lotus-Notes. 

f. Click OK. 

5. On the View menu, click Show Most Recent Backup. 

6.
 On the View menu, click Refresh. 

NetBackup browses for Lotus database backup images. 

7. Select the database files you want to restore. 

Note
 While it is possible to select transaction log extents to restore, in general, it is not 
recommended to do so. If a transaction log extent is required to recover a database, 
the transaction log extent will be restored automatically as part of the database 
recovery and recycled automatically by the Domino server when the transaction log 
extent is no longer required. 

Note
 The Browse Directory box is not available when browsing for Lotus-Notes backups 
on a NetBackup client. 
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Performing a Restore 
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Performing a Restore 
8. Click Restore. 
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Performing a Restore 
The Restore Files dialog box is displayed, with the Lotus Notes tab displayed. 

9. Enter the following information as described below: 

◆	 Time to wait for the database to go offline: This field allows the user to specify 
the number of seconds that the restore process will wait for a busy database. 
When a Lotus database is to be restored it needs to be taken offline. This will 
ensure that the database is not being accessed, close the database, and delete the 
database. If the database is being accessed it cannot be taken offline. If the 
database is still busy and not able to be taken offline after the specified wait time, 
the restore of that database will fail. 

◆	 Database Identification: The user can assign a new database instance ID (DBIID), 
assign a new database instance ID (DBIID) and a new replica ID, or retain the 
original database instance ID (DBIID) and replica ID during the restore. 
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Performing a Restore 
The replica ID is used to synchronize two or more databases that are being 
replicated in the Lotus Domino environment. The user may select to assign a new 
replica ID during a restore to prevent the other database(s) under replication from 
replicating over the restored database files. 

◆	 Recover database to the specified point in time: If the user selects to assign a 
new database instance ID (DBIID), or assign a new database instance ID (DBIID) 
and a new replica ID, the user will have the option to recover the selected 
database(s) to a specific point in time. 

The user will click the Recover database to the specified point in time checkbox 
to enable the date and time controls. The date and time can now be set for the 
restore process. 

◆	 Wait until resources are available: Click this checkbox to wait for Lotus Domino 
Server Resources to become available before starting the restore process. 

◆	 Specify the absolute path for the NOTES.INI file associated with the server 
instance to be used: When restoring on a Domino partition server, the user can 
specify the absolute path for the notes.ini file associated with the particular 
server partition that will be used to perform the restore. The server partition 
specified will have an impact on how a database is restored (if logged) and which 
set of transaction logs will be used for recovery. 
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Performing a Restore 
10. Click on the General tab. 

11. Click Start Restore. 
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Redirecting a Restore to a Different Client 
This section describes how to redirect a restore to a different client. A restore redirected to 
a different client is performed just like a regular restore, except that a different destination 
client, and, possibly, a different source client is selected. For complete information on 
performing restores, see “Performing a Restore” on page 62. 

▼ To select a different destination (and source) client 

1. Open a Restore window. 

2.	 Choose Actions > Specify NetBackup Machines. 

The Specify NetBackup Machines dialog box is displayed. 

3. Click on the Source client tab. 

a. Select the source client in the Client list box and click Make Current. 

The source client is the machine name whose backup images you would like to 
browse. 

b. From the Policy type drop-down list, select Lotus-Notes. 

4. Click on the Destination client tab. 

a.	 In the Client list box, enter the client to which to redirect the restore. The 
NetBackup for Lotus Notes agent must be installed on the destination client. 

5.	 Click OK. 

NetBackup will browse the NetBackup Catalog for Lotus Notes backup images. 
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Redirecting a Restore to a Different Client 
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Lotus Domino Clustering 
5


Domino clustering technology can provide high availability, load balancing, and 
scalability for your Lotus Domino Server environment. Domino clustering uses 
event-driven replication to keep data in all Domino Servers in the cluster in sync. Domino 
clustering is a type of  “software” clustering. As such, Domino clustering provides 
failover of databases to an available Domino Server. Domino clustering does not provide 
failover of the Domino Server itself, as would be expected in a “hardware” clustering 
environment. 

Up to six Domino Servers within the same Notes domain may exist in a Domino cluster. A 
Domino Server may be a member of a single Domino cluster; however, a Notes domain 
may have more than one Domino cluster. 
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Lotus Domino Clustering Components 
Several components work together to control a Domino cluster. These include the Cluster 
Manager, the Cluster Database Directory, the Cluster Database Directory Manager, and 
the Cluster Replicator. 

The Cluster Manager runs on each server in a Domino cluster and monitors the state of the 
other Domino Servers in the Domino cluster. The Cluster Manager performs the following 
tasks: 1) determines which Domino Servers belong to the Domino cluster, 2) monitors for 
server availability and workload, 3) fails over database requests due to unavailability of a 
Domino clustered server, and 4) performs workload balancing. 

The Cluster Database Directory (CLDBDIR.NSF) is replicated on every server in a Domino 
cluster. The Cluster Database Directory contains information such as file name, server, 
replica ID, cluster replication status, and out of service information for each database on 
each Domino Server in the Domino cluster. The different cluster components use this 
information to perform their tasks. 

The Cluster Database Directory Manager (CLDBDIR) task on each Domino Server manages 
the Cluster Database Directory and keeps it up-to-date. The Cluster Database Directory 
Manager also monitors the status of each database to determine if they are out of service 
or pending delete. 

The Cluster Replicator (CLREPL) task constantly synchronizes the database replicas in a 
Domino cluster. Because the Cluster Replicator is event-driven, rather than 
schedule-driven, as in traditional replication, changes that occur to a database in the 
Domino Cluster are immediately pushed to the other replicas in the Domino cluster.  This 
ensures that each time a database is accessed they contain the most up-to-date data. The 
Cluster Replicator task will push changes only to those Domino Servers in a Domino 
cluster. The traditional scheduled replication is used to replicate changes to and from 
Domino Servers outside a Domino cluster. 

Because Domino stores replication events in memory only, both the source and 
destination servers must be available for the replication to complete successfully. If a 
destination server is not available, the Cluster Replicator task on the source server will 
continue to store the replication events in memory until the destination server becomes 
available. If the source server shuts down before the replication completes, the replication 
events in memory will be lost. To prevent this loss of data, standard replication should be 
configured to perform immediate replication with all members of the Domino cluster 
whenever a Domino cluster server is restarted. It is also recommende-styled that 
scheduled replication between Domino clustered servers be performed on a regular basis 
to help maintain database consistency for all members of the Domino cluster. 
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Backing up a Lotus Domino Replicated or Clustered 
Environment 

If using transaction logging, it is recommended that when configuring your Domino 
cluster environment: 

◆	 Archive-style logging be enabled on the Domino Server that will function as your 
backup server. 

◆	 Circular- or linear-style logging be enabled on all other Domino Servers in the 
Domino cluster. 

By running circular-style or linear-style logging on the non-backup Domino Servers, 
all the advantages of transaction logging such as data reliability and integrity and 
improved Domino Server performance can be attained without having to manage 
(recycle) the archival-style transaction logs. 

It is also recommended that such non-database Domino files as the notes.ini, user and 
server certificates ids, the CLUSTER.NCF file also be backed up as part of the standard 
backup. 
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Restore/Recovery in a Lotus Domino Replicated or 
Clustered Environment 

Because Domino clustering is a “software” clustering solution that relies on software 
replication to provide consistency of the databases across all members of the Domino 
cluster, the replica ID plays an important role in achieving the expected results when 
attempting to restore a Domino database from backup. Understanding how replication 
functions is vital to achieving the expected result. The following examples illustrate two 
possible restore/recovery scenarios. 

Example 1 

The environment is a Lotus Domino Clustered environment with four Lotus Domino 
Servers as members of the Domino cluster. Server A is identified as your backup server 
and is running archive-style transaction logging. Servers B, C, and D are running circular-
or linear-style logging.  To provide load balancing across all the Domino Servers, replicas 
of all databases exist on all four servers in your Domino cluster. A successful full backup 
of all databases was completed earlier in the week.  Successful incremental backups of the 
archival-style transaction logs are completed every four hours, with the last one 
completing 2 hours ago. At 2:30 pm, a user complains that the database ACME.NSF has 
become corrupted, while modifying the database on server C over the last 30 minutes. 
Unfortunately, because the environment is a Domino cluster environment, the corruption 
has been replicated to all four member servers. The user states that the database was in a 
consistent state when he began modifying the database. 

▼ To restore the database to a consistent state: 

1.	 On server A, perform a point-in-time recovery of the database ACME.NSF. Select the 
database ACME.NSF from the last successful backup of the database (eg. the full 
backup completed successfully earlier in the week). Begin the restore. 

2.	 On the Lotus Notes tab of the Restore Marked Files dialog box, select the Assign new 
database ID and replica ID option, select the Restore database(s) to date and time 
option, and specify today's date at 2:00 pm (the time the user started modifying the 
database) as the point-in-time for recovery. 

3.	 After the restore/recovery is successful, a version of ACME.NSF recovered to today at 
2:00 pm should exist on server. Verify the consistency of ACME.NSF on server A. If all 
is as expected, from server A create new replicas of ACME.NSF on servers B, C, and D. 
Cluster replication on a consistent version of ACME.NSF should now be functional on 
servers A, B, C, and D. 
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Example 2 

The environment is a Lotus Domino Clustered environment with three Lotus Domino 
Servers as members of the Domino cluster. Server C is identified as your backup server 
and is running archive-style transaction logging. Servers A and B are running 
circular-style or linear-style logging. To provide high availability and load balancing of 
mail, replicas of all mail databases between A-L exist on servers A and C and replicas of 
all mail databases between M-Z exist on servers B and C. A successful full backup of all 
databases was completed earlier in the week. Successful incremental backups of the 
archive-style transaction logs are completed every four hours, with the last one 
completing 2 hours ago.  A user complains that he has just realized that yesterday 
afternoon about 3:30 pm he deleted 30 mail messages from his mail database mander.nsf 
that should not have been deleted. 

▼ To recover the accidentally deleted mail: 

1.	 On server C, perform a point-in-time recovery of the database /mail/mander.nsf. 
Select the database /mail/mander.nsf from the last successful backup of the database 
(e.g., the full backup completed successfully earlier in the week). Begin the restore. 

2.	 On the Lotus Notes tab of the Restore Marked Files dialog box, select the Assign new 
database ID and replica ID option, select the Restore database(s) to date and time 
option, and specify yesterday's date at 3:25 pm (the time just prior to when the user 
deleted the mail messages) as the point-in-time for recovery. 

3.	 After the restore/recovery is successful, a version of /mail/mander.nsf recovered to 
yesterday at 3:25 pm and containing the deleted messages should exist on server C. 
Verify the existence of messages in /mail/mander.nsf on server C. If all is as expected, 
copy the accidentally deleted messages from /mail/mander.nsf on server C to the 
database on server B. 

4.	 After the copy, verify the existence of the messages in /mail/mander.nsf on server B. 
If all is as expected, from server B create a new replica of /mail/mander.nsf on server 
C. Cluster replication should now be functional for /mail/mander.nsf on servers B 
and C. 

It is important to note in the example above that the Assign new database ID and replica 
ID option was chosen. If the Assign new database ID option had been chosen instead, the 
final results of the recovery would have been very different. As in the example above, the 
restore of the database /mail/mander.nsf functions the same, except the replica ID is not 
changed. The database would have then been recovered to the specified point-in-time. 
However, because the replica ID of the database /mail/mander.nsf on server C had not 
been changed as part of the restore, the replica ID of the database on server C still matches 
the replica ID of the database on server B. Therefore, all the changes to the database 
between the point-in-time the database was recovered to and the current time, including 
the deletion of the 30 mail messages, will eventually be replicated from the database on 
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server B to the database on server C. The final result will be two identical copies of the 
database /mail/mander.nsf, one on server B and the other on server C, that are the same 
as when we started restoring the database /mail/mander.nsf on server C. 
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Lotus Domino Partitioned Servers 
6


Domino partitioned servers allow multiple Domino Servers to run on a single computer. 
The advantages of using Domino partitioned servers are to reduce hardware expenses 
and minimize the number of computers that need to be administered. Each Domino 
partitioned server has its own Domino data directory and notes.ini file, but all 
Domino partitioned servers on a single computer share the same Domino program 
directory. 

Lotus recommends using different user accounts for each Domino partitioned server to 
allow easier use of such commands as nsd to clean up orphaned processes after a Domino 
Server crash.  To accommodate this recommendation, the NetBackup for Lotus Notes for 
UNIX agent will easily support backups and restores of multiple Domino Server 
partitions each using a different UNIX user account. It is possible to backup multiple 
Lotus partitions from a single NetBackup policy, however, each partition must be backed 
up using a separate data stream. 

Backups in a Domino Partitioned Server Environment 
The following examples illustrate two possible configurations of the Backup Selections list 
that could be used to backup a Lotus partitioned server environment. 

Example 1 

The environment is a Domino partitioned server environment running with two 
partitions. The Domino data directory for partition 1 is located at /db/notesdata1 and 
the Domino data directory for partition 2 is located at /db/notesdata2. To backup this 
environment with two separate NetBackup policies, the following would be added to the 
Backup Selections list: 

Policy 1 

NOTES_INI_PATH=/db/notesdata1/notes.ini


/db/notesdata1
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Policy 2 

NOTES_INI_PATH=/db/notesdata2/notes.ini


/db/notesdata2


Example 2 

The environment is a Domino partitioned server environment running with three 
partitions. The Domino data directory for partition1 is located at /db/notesdata1, the 
Domino data directory for partition 2 is located at /db/notesdata2, and the Domino 
data directory is located at /db/notesdata3. Each partition is configured to use 
archive-style transaction logging.  To back up this environment using a single NetBackup 
policy, the following would be added to the Backup Selections list: 

Policy 1 

NEW_STREAM


NOTES_INI_PATH=/db/notesdata1/notes.ini


/db/notesdata1


BACKUP_TRANSACTION_LOGS


NEW_STREAM


NOTES_INI_PATH=/db/notesdata2/notes.ini


/db/notesdata2


BACKUP_TRANSACTION_LOGS


NEW_STREAM


NOTES_INI_PATH=/db/notesdata3/notes.ini


/db/notesdata3


BACKUP_TRANSACTION_LOGS


Restoring a Domino Partitioned Server Environment 
As with restores of a non-partitioned Domino Server environment, restores of a 
partitioned server environment must be performed as the user that owns the Domino data 
directory for the partition being restored.  For Lotus Domino Server, the notes.ini file 
determines how a database to be restored is accessed and which Lotus transaction log 
extents to use for recovery. Because each partition in a Domino partitioned server 
environment has its own notes.ini, it is required that Lotus databases from different 
partitions must be restored in separate restore operations. 
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Troubleshooting 
7


The NetBackup master server and client software offers a comprehensive set of debug 
logs for troubleshooting problems that may occur during NetBackup operations. Debug 
logs are covered in detail in the NetBackup Troubleshooting Guide for UNIX and Windows. 

If you are experiencing problems backing up or restoring databases or transaction log 
extents, and the cause of the problem cannot be determined from standard NetBackup 
progress reports, you may enable NetBackup debug logs to aid in determining the cause 
of the problem. Debug logging is enabled by creating certain directories under the 
NetBackup Logs directory. 

The following topics cover troubleshooting of NetBackup: 

◆ Backup Operation Debug Logging 

◆ Restore Operation Debug Logging 

◆ Changing the Debug Level 

◆ Viewing the Status of a NetBackup Operation 

Backup Operation Debug Logging 
To turn on debug logging for backup operations, create the following directory: 

/usr/openv/netbackup/logs/bpbkar


After creating this directory and performing a backup, debug logging information will be 
placed in the following file: 

/usr/openv/netbackup/logs/bpbkar/mmddyy.log
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Restore Operation Debug Logging 
To turn on debug logging for restore operations, create the following directory: 

/usr/openv/netbackup/logs/tar


After creating this directory and performing a restore, debug logging information will be 
placed in the following file: 

/usr/openv/netbackup/logs/tar/mmddyy.log


For details on the contents of these debug logs, refer to the NetBackup Troubleshooting Guide 
for UNIX and Windows. After the cause of the problem has been determined, debug 
logging can be disabled by removing the previously created debug logging directories. 

Note	 When debug logging is enabled, the files can become large. The same files are used 
by normal file backups. 
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Changing the Debug Level 
Changing the Debug Level 
You can control the amount of information written to the debug log in the 
install_path/NetBackup/logs/bpbkar directory by changing the General debug 
level. The higher the value, the more information is logged. In everyday normal 
operations, the default value of 0 is sufficient. However, VERITAS technical support may 
ask you to set the value higher when a problem is being analyzed. 

▼ To change the Debug Level 

1.	 Enter the following line in the bp.conf file. 

VERBOSE = 2 

Viewing the Status of a NetBackup Operation 
NetBackup provides many standard status reports to verify the completion of backup and 
restore operations. In addition, users and the administrator can set up additional reports if 
a site requires them. 

Operational Reports 
The administrator has access to operational progress reports through the NetBackup 
Administration Console. Reports may be generated for Status of Backups, Client Backups, 
Problems, All Log Entries, Media Lists, Media Contents, Images on Media, Media Logs, 
Media Summary, and Media Written. These reports may be generated for a specific time 
frame, client, or master server. Refer to NetBackup System Administrator’s Guide for 
Windows, Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for details. 

Progress Reports 
Progress reports on the client allow easy monitoring of user operations. When reports are 
created by the NetBackup client for each user-directed backup or restore operation, 
administrators can monitor these operations and detect any problems that may occur. 

▼ To view the status of an operation 

1. Click the Task Progress tab. 

2. Click Update Task List. 

3. Click on the task for which you want to check the progress. 
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Viewing the Status of a NetBackup Operation 
The status of the operation is displayed in the lower pane. 

When the requested operation was successfully completed message 
appears, the NetBackup operation is finished. (See your NetBackup Backup, Archive, and 
Restore Getting Started Guide for further information on the progress report and the 
meanings of the messages.) 
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